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1 Data Input Console Help

1 Data Input Console Help

What is Data Input Console?

Data Input Console allows you to collectively set the following types of information on users and devices
while initializing or operating ApeosWare Management Suite.

e Device Information

e Folder

e Address Book

e Logical Printer Information

Printer Information

It also allows you to retrieve and edit the above-mentioned information specified on ApeosWare
Management Suite, and then register the information again on ApeosWare Management Suite.

The information that can be set using Data Input Console is also referred to as "attributes".

Flow of Operations

This section describes the flow of operations for consolidating and setting attributes to ApeosWare
Management Suite using Data Input Console.

1.Start Data Input Console.
Retrieve the information.

e Read from ApeosWare Management Suite.
e Read from a CSV file.

2. Edit the data.

3. Reflect the edited data in ApeosWare Management Suite.

Ellj Note

The edited data can be exported as a CSV file.

4., Check the data applied.

5. Exit Data Input Console.



Menus and Dialog Boxes

Menus and Dialog Boxes

Menus

[File] menu
o [Retrieve Attributes from Device]
[Specify Device to Retrieve Attribute] dialog box is displayed.

o [Retrieve Attribute]
Displays the [Specify Attribute to Retrieve] dialog box.

e [Save Attribute]
Displays the [Specify Attribute to Save] dialog box.
e [Export (CSV)]
The [Specify Sheet to Export] dialog box is displayed. Select the sheet to be exported.
e [Save Current State]
Saves the value entered in the input field.
o [Exit]
Exits Data Input Console.

[Edit] menu
o [Cut]
Cuts the data of the cell currently selected.

e [Copy]
Copies the data of the cell currently selected.

o [Paste]
Pastes the cut or copied data to the cell currently selected.

o [Delete]

Deletes the data of the cell currently selected.
° [Fil’]d]

Searches the values entered in the cells.

[Tool] menu
e [Log Settings]
Displays the [Log Settings] dialog box.

[Help] menu

e [Help]
Displays this help.

e [Home Page]
Displays the home page of ApeosWare Management Suite product information or the home page of
FUJIFILM Business Innovation.

[ApeosWare Management Suite]
Displays the home page of ApeosWare Management Suite product information in the Web browser.
[FUJIFILM Business Innovation]
Displays the home page of FUJIFILM Business Innovation in the Web browser.
o [About]
Displays the version of your Data Input Console.



1 Data Input Console Help

Dialog Boxes

Select Language

Select the language to be used in Data Input Console.

Language
Select [English] or the language set for the system locale in Regional and Language Options of Windows.

[OK]
Saves the content set, and closes this dialog box.

[Cancel]
Cancels the content set, and closes this dialog box.

Find
This dialog box allows you to search for data in the data input area.

Find Text
Enter the string to search for. You can enter 0 to 512 characters.
Single-byte and double-byte characters can be mixed.

Search Method
Select one of the following methods.

e Match Entire Contents
Searches for strings that exactly match the string entered in [Find Text].

e Contains in Contents
Searches for strings that contain the string entered in [Find Text].

[Find Next]
Searches in the data input area and stops the cursor at a cell matching the condition.
This function is valid within the sheet where the cursor is placed.
The range of search varies depending on the selection status of the cells.

e When only one cell is selected
All cells in the sheet are searched.

e When multiple cells are selected
Only the selected cells are searched.

When no cell is found to match the search condition, the message "The data matching the search
condition was not found" appears.

[Close]
Ends the search and closes this dialog box.

Log Settings

To set the output destination of the operation log and the type of operation log to be output, use the
following steps:

Logged Contents
Set the type of log to be output.

e Errors
Outputs a log of faults only.



e Errors and Warnings
Outputs the log of faults and warnings.

e Errors, Warnings, and Information
Outputs the log of faults, warnings, and information.

Storage Location

Menus and Dialog Boxes

Enter the folder where the log file is to be stored. You can enter O to 260 characters.

Single-byte and double-byte characters can be mixed.
The default value is "{data storage folder}\Data\Logs\Tools".

[Browse]

Displays the [Browse For Folder] dialog box. Use this dialog box to specify the folder in which to store

the log file.

[OK]
Saves the content set, and closes this dialog box.

[Cancel]
Cancels the content set, and closes this dialog box.

About

Displays the version information of your Data Input Console.

[Close]
Closes this dialog box.

Select devices

Specify devices from which attributes are retrieved.

Search Device
Put a checkmark on [Address Book] or [Folder].

Search by

Display [Add Search Condition] dialog box and set the searching condition of devices.

Device Communication Settings

Display [Communication Settings] dialog box and set communication of checkmarked devices in the list.

Delete
Delete checkmarked devices in the list.

Add Search Condition

Protocol to be used for search
Select the protocol to search.

Condition of searching range

If [SNMP v1/v2] or [SNMP v3] is specified in [Protocol to be used for search], set the input item of the

searching range.

Add Search Condition
Specify the searching range.
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Port number
Input the port number.

Communication Timeout

Input the communication time-out time.

[OK]
Save the set contents and close this dialog box.

[Cancel]
Discard the set contents and close this dialog box.

Communication Settings

Machine controller information
Input the machine controller ID and password for communication with devices.

Port number
Input the port number for SOAP communication with devices.

[OK]
Save the set contents and close this dialog box.

[Cancel]
Discard the set contents and close this dialog box.

Specification of attributes retrieved from devices

Specify attributes retrieved from devices.

Retrieval source
Put a checkmark on either [Address Book] or [Folder].

[Start]

Close this dialog box and start retrieval of attributes.

While attributes are being retrieved, the progress is displayed in [Retrieval of attributes] dialog box.
[Cancel]

Discard the set contents and close this dialog box.

Specify Attribute to Retrieve

Specify the target from which to retrieve the attributes. Multiple items can be selected.

Device Information

Select this check box when retrieving the attributes of the device information used in ApeosWare
Management Suite.

Logical Printer Information

Select this check box when retrieving the attributes of the logical printer used in ApeosWare
Management Suite.
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Address Book

Select this check box when retrieving the attributes for Address Book used in ApeosWare Management
Suite.

Folder
Select this check box when retrieving the attributes for Folder used in ApeosWare Management Suite.

Printer Information

Select this check box when retrieving the attributes for Printer Information used in ApeosWare
Management Suite.

[Start]
Closes the dialog box and starts the attributes retrieval.
While the attributes are being retrieved, the progress is displayed in the [Retrieve Attribute] dialog box.

[Cancel]
Cancels the content set, and closes this dialog box.

Specify Attribute to Save
Specify the target for which to set the attributes. Multiple items can be selected.

Device Information
Select this check box when specifying the attributes of the device information used in ApeosWare
Management Suite.

Logical Printer Information

Select this check box when specifying the attributes of the logical printer used in ApeosWare
Management Suite.

Address Book

Select this check box when setting the attributes for Address Book used in ApeosWare Management
Suite.

Folder
Select this check box when setting the attributes for Folder used in ApeosWare Management Suite.

Printer Information

Select this check box when setting the attributes for Printer Information used in ApeosWare
Management Suite.

[Start]
Closes the dialog box and starts the attribute settings.
While the attributes are being set, the progress is displayed in the [Save Attribute] dialog box.

[Cancel]
Cancels the content set, and closes this dialog box.

Retrieve Attribute/Save Attribute

This dialog box allows you to view the progress of the retrieval or setup of attributes as a progress bar.

Progress Bar
Displays the progress of the retrieval or setup of attributes.
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[Cancel]
Aborts the retrieval or setup of attributes and closes this dialog box.

Attribute Retrieval Result/Attribute Save Result

This dialog box allows you to view the results of attribute retrieval or attribute setup.

“Details of attributes that cannot be retrieved” or “Details of attributes that cannot be set”
Displays the sheet name of the sheet containing the attributes that could not be retrieved or set up,

together with the details.
[OK]
Closes this dialog box.

Logical Printer > LPR Queue (Setting)

This is displayed when you select [On] in the [LPR Queue] column of the [Logical Printer] sheet and then
click a link in the [LPR Queue Settings] column.

Add, change or delete an LPR queue.

C,I—\l Note

"(Setting)" is not displayed in the title of the dialog box.
It is described here to distinguish Help topics

LPR Queue
Lists LPR queue names and character sets.
To add, change or delete an LPR queue, select this.

[Add]
To add an LPR queue, click this.
The [LPR Queue] (Add/Change) dialog box is displayed.

[Change]
To change an LPR queue, select the LPR queue and then click this.
The [LPR Queue] (Add/Change) dialog box is displayed.

[Delete]
To delete an LPR queue, select the LPR queue and then click this.
The LPR queue is deleted.

[OK]
Saves the content set, and closes this dialog box.

[Cancel]
Cancels the content set, and closes this dialog box.

Logical Printer > LPR Queue (Add/Change)

Displayed when clicking the [Add] or [Change] button in the [LPR Queue] (Setting) dialog box.
Adds or changes an LPR queue.

Ll_l_“\ Note

The "(Add/Change)" above is not displayed in the title of the dialog box.
It is described here to distinguish Help topics.
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Queue Name

Enter a queue name.

Menus and Dialog Boxes

You can enter 0 to 256 single-byte alphanumeric characters, hyphens (-) and underscores (_).

The default value is [Ip].

Character Set

From the drop-down list box, select a character set.

Select the character set to suit your computer environment and the data code to be printed.

You can select from the following items.
The default value is [UTF-8(Unicode)].

[OK]

Shift JIS/CP932(Japanese)
GBK/CP936(Simplified Chinese)
Big5/CP950(Traditional Chinese)
EUC-KR/CP949(Korean)
Windows-1252(English)
UTF-8(Unicode)
EUC-JP-LINUX(Japanese)

Saves the content set, and closes this dialog box.

[Cancel]

Cancels the content set, and closes this dialog box.

11
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Operation Description

Starting / Exiting Data Input Console

Starting Data Input Console

1. From the menu to launch Windows programs, select [FUJIFILM ApeosWare Management Suite] >
[Data Input Console].
The [Select Language] dialog box appears.

l/i—li\ Note

When the system locale in Windows Regional and Language Options is set to [English (United States)],
[Select Language] dialog box is not displayed.

2.Select the language, and click [OK].
Data Input Console starts.

|,l_|—\| Note

If Data Input Console fails to start, a message indicating that appears.
Follow the instruction in the message.

Exiting Data Input Console

1. From the [File] menu, select [Exit].

Importing Setting Date
Importing from CSV files

To import a user-created CSV file to Data Input Console, perform the following procedure:
Ensure that the CSV file meets the following requirements:

e File size is within 4GB

e Within 100,000 rows, 256 columns

Li_l_“\ Note

You cannot import the information such as passwords in plain text.

1. Click the [Import (csv)] button on any of the sheets.
A dialog box to select a file appears.

2.Select the CSV file to be imported, and click [Open].
The loaded data is displayed on each sheet.

Importing from ApeosWare Management Suite

Import the attributes to be set using Data Input Console from ApeosWare Management Suite.

1.From the [File] menu, select [Retrieve Attribute].
The [Specify Attribute to Retrieve] dialog box appears.

12



Operation Description

2.Select the check box for the item whose attributes are to be retrieved, and click [Start].
The retrieval starts.The progress status is displayed in the [Retrieve Attribute] dialog box.

When the retrieval is completed, the message "The attribute has been retrieved." appears.

When some of the attributes could not be retrieved, the [Attribute Retrieval Result] dialog box is
displayed.

3. Click [OK].

Editing Date
Operating Tree

In the left area of Data Input Console, the features available are displayed in a tree format.

Selecting an item in the tree displays the sheet corresponding to the selected items in the area at the
right side.

You can enter or edit data on the sheet.

For more details on the items in the sheet, see ApeosWare Management Suite Help.

Data Input Console
Clicking this displays the [Tool Summary] sheet in the area at the right side.

e Logical Printer
Clicking this displays the [Logical Printer] sheet in the area at the right side.

e Device Information
Clicking this displays the [Device Information] sheet in the right area.

e Folder
Clicking this displays the [Folder] sheet in the area at the right side.

e Recipient Information
Clicking this displays the [Fax] sheet in the area at the right side.
Clicking the tab on the top of the sheet switches the sheet displayed.
- [Fax] tab
Displays the [Fax] sheet.
« [IP Fax (SIP)] tab
Displays the [IP Fax (SIP)] sheet.
+ [Internet Fax] tab
Displays the [Internet Fax] sheet.
+ [E-mail Address] tab
Displays the [E-mail Address] sheet.
« [Server] tab
Displays the [Server] sheet.

Buttons on Each Sheet

See the following description for the buttons displayed on each sheet.

[Logical Printer] sheet

e [Import (csv)]
A dialog box to select a file is displayed. Specify the CSV file to import.

e [Export (csv)]
The [Specify Sheet to Export] dialog box is displayed. Specify the sheet to export.

13
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e [Retrieve Attribute]
The [Specify Attribute to Retrieve] dialog box is displayed. Select the item to retrieve the attribute
from.

e [Save Attribute]
The [Specify Attribute to Save] dialog box is displayed. Select the item to configure.

[Device Information] sheet
e [Import (csv)]
A dialog box to select a file is displayed. Specify the CSV file to import.
e [Export (csv)]
The [Specify Sheet to Export] dialog box is displayed. Specify the sheet to export.

o [Retrieve Attribute]
The [Specify Attribute to Retrieve] dialog box is displayed. Select the item to retrieve the attribute
from.

e [Save Attribute]
The [Specify Attribute to Save] dialog box is displayed. Select the item to configure.

[Folder] sheet
e [Import (csv)]
A dialog box to select a file is displayed. Specify the CSV file to import.
e [Export (csv)]
The [Specify Sheet to Export] dialog box is displayed. Specify the sheet to export.

o [Retrieve Attribute]
The [Specify Attribute to Retrieve] dialog box is displayed. Select the item to retrieve the attribute
from.

e [Save Attribute]
The [Specify Attribute to Save] dialog box is displayed. Select the item to configure.

Sheets in [Recipient Information]
e [Import (csv)]
A dialog box to select a file is displayed. Specify the CSV file to import.

e [Export (csv)]
The [Specify Sheet to Export] dialog box is displayed. Specify the sheet to export.

e [Retrieve Attribute]
The [Specify Attribute to Retrieve] dialog box is displayed. Select the item to retrieve the attribute
from.

o [Save Attribute]
The [Specify Attribute to Save] dialog box is displayed. Select the item to configure.

Link Cells

A link string is displayed in a link cell. The default value is <Not specified>.
Clicking a link displays the dialog box for setting items.
Setting the items and then clicking [OK] in the dialog box applies the link setting to the link cell.

Link cells are specified in columns such as the [Device Group to Associate] on the [Logical Printer] sheet.

14
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Title and Data Input Area

Clicking a tree item in the left area of Data Input Console displays the corresponding sheet in the right
area of the window.

The tablespace area provided for data entry in the sheet is referred to as data input area.
The data input area consists of the cells for entering data and the titles.

Title

Displays the attribute name of the row. "Required" is appended with the title if it cannot be left blank.
Clicking the title sorts the data in the column.

Cell
The data in a cell can be edited as follows:
e Multi-selecting Cells
e Copying / Pasting Cells
e Deleting Cell Data

e Executing Searches

Operating Cells

To operate the cells in the data input area, perform the following steps:

Multi-selecting Cells

1. Click the topmost cell of the area to be selected.

2.Execute the following operations depending on the area to be selected:
+ When selecting a rectangular area, click the cell in the top-left corner of the area, and drag to the
bottom-right cell.
- To select a continuous range, click the cell at the end of the selected range while pressing the
<Shift> key. Or, press <Shift> + arrow key.
+ When selecting a discontinuous area, click the selected cell while holding down the <Ctrl> key.

Copying / Pasting Cells

LL_|_\\ Note

Password cannot be copied or pasted.

1. Select the cell containing the data to be copied.
2.From the [Edit] menu, select [Copy].
3. Click the cell in which to paste the data copied.
4. From the [Edit] menu, select [Paste].

Deleting Cell Data

1. Select the cell containing the data to be deleted.

2.From the [Edit] menu, select [Cut] or [Delete], or press the <Delete> key.

15
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Executing Searches

This dialog box allows you to search for data in the data input area.

Ll_l_\| Note

Passwords cannot be searched for.

1.From the [Edit] menu, select [Find].
The [Find] dialog box is displayed.

2.In [Find Text], enter the string to search for.
You can enter O to 512 characters.

Single-byte and double-byte characters can be mixed.

3. Selects the search method.
Match Entire Contents
Searches for strings that exactly match the string entered in the string to be searched.
+ Contains in Contents
Searches for strings that contain the string entered in in the string to be searched.

4. Click [Find Next].
The cursor moves to the cell in the data input area that matches the search condition.

When no cells are found to match the search condition, the message "The data matching the search
condition was not found" appears.

5. When you have completed a search, click [Close].

Sorting

To sort the data of the cell selected in the data input area, use the following steps:

1. Click the header of the cell to be sorted.

I/L_lj Note

Cells containing numbers are sorted in ascending order.

- Cells containing text are sorted in the order of numbers (0 to 9), symbols, and alphabetic characters
(alphabetical order).

- The sorting direction of the cells is toggled between ascending and descending with each click of the
header cell.

+ Empty cells are moved below filled cells.
- Passwords are indicated and sorted as [*] regardless of their actual values.

Update the data.

Applying Data Setup
Apply the data you have set in Data Input Console to ApeosWare Management Suite.

1.From the [File] menu, select [Save Attribute].
The [Specify Attribute to Save] dialog box is displayed.

2.Select the check box for the item whose attributes are to be retrieved.

3. Click [Start].
The progress status is displayed in the [Save Attribute] dialog box.

To cancel the setup of the attribute, click [Cancel].

16
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Delete Applied Data

The attribute data selected on Data Input Console can be deleted from ApeosWare Management Suite.

1.0n a sheet that has the items you want to delete, select the check box for [Delete] in the target
column.

2.Select [Save Attribute] from the [File] menu.
The [Specify Attribute to Save] dialog box is displayed.

3. Select the check box for the item whose attributes are to be deleted.

4. Click [Start].
The progress is displayed in the [Save Attribute] dialog box.

Click [Cancel] to cancel saving the attribute.

Confirming Data Setup Results
Check the data you have applied to ApeosWare Management Suite.

1. Close the dialog box by clicking [OK] in the message "The attribute has been saved." or in the
[Attribute Save Result] dialog box.
When the retrieval of attributes is completed successfully, the message "The attribute has been saved."
appears.
When some of the attribute values could not be set, the results are displayed in the [Attribute Save
Result] dialog box.

2.1n the window of Data Input Console, check [Result] added in the leftmost section of the data input
area.
- Blank
The data has not been applied because the operation was aborted.
- Updated
The updated data has been reflected.
+ Registered
The new data has been reflected.
- Failed
Applying of data failed.

Cllil Note

[Result] is discarded when Data Input console terminates.

Exporting the settings

Exports the settings made on Data Input Console in the CSV file format.

LL_|_\\ Note

- A CSV file is output as "UTF-8 (With BOM)".
+ Information such as passwords is encrypted and exported.

1. Click the [Export (CSV)] button on any of the sheets; or select [Export (CSV)] from the [File] menu.
The [Specify Sheet to Export] dialog box is displayed.

2.Specify a sheet to export and click [Start].
A dialog box to specify the location to save the CSV file is displayed.

17
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3. Specify the location to save and click [OK].
The settings made on Data Input Console is exported.

Log Settings

To set the output destination of the operation log and the type of operation log to be output, perform
the following procedure.

1. From the [Tool] menu, select [Log Settings].
The [Log Settings] dialog box is displayed.

2.Set the type of error to be recorded in the log and the location where the log is to be stored, and click
[OK].
Displaying Home Page

To display the home page of ApeosWare Management Suite or the home page of FUJIFILM Business
Innovation, perform the following procedure:

e Displaying ApeosWare Management Suite Home Page
e Displaying FUJIFILM Business Innovation Home Page

Displaying ApeosWare Management Suite Home Page

To display the home page of ApeosWare Management Suite, perform the following step.

1.From the [Help] menu, select [Home Page] > [ApeosWare Management Suite].
The home page of ApeosWare Management Suite is displayed.

Displaying FUJIFILM Business Innovation Home Page

To display the home page of FUJIFILM Business Innovation, perform the following step.

1.From the [Help] menu, select [Home Page] > [FUJIFILM Business Innovation].
The home page of FUJIFILM Business Innovation is displayed.

Displaying Version Information

Displays the version information of your Data Input Console.

1.From the [Help] menu, select [About].
The [About] dialog box is displayed.

2.Click [Close].

Backing-up/Restoring

To backup the settings for Data Input Console, save the following file in any location.
{data storage folder}\Data\Data\AWDIC
To restore them, copy the backup settings to the folder above mentioned.

lil—\\ Note

The default setting for {data storage folder} is "C:\FUJIFILM\ApeosWare MS".

18



What is Update Service?

2 Update Service Help

What is Update Service?

The primary features of Update Service are as follows.
e Provides patch applications for the malfunctions or upgrading of target software.

e Registers a driver corresponding to the printer registered in Device Management (Installing in Server
Mode)

e Retrieves notifications from FUJIFILM Business Innovation

Installing in Server Mode

Operation Procedures

Starting/Exiting Update Service

Starting Update Service

1. Start your computer and log in as a user with Administrators permissions.
Update Service also starts automatically and the icon is displayed on the task tray.

I/L_lj Note

When Update Service does not start, or when restarting after exiting Update Service, select [FUJIFILM
ApeosWare Management Suite] > [Update Service] > [Update Service - Update Now] in this order from
the menu which makes Windows programs start.

- Theicon is displayed by default, but it is not displayed when [Hide (Display temporarily when update
result is received)] on the [General] tab is selected.

The following two types of icons are displayed on the task tray.

. (No Notification Incoming)
. (Notification Incoming)

For details of the icons, see "lcon" (P.24).

Exiting Update Service

1.Right-click the (Not receiving Update Notification) icon.

2.Select [Exit] from the menu.
Update Service exits.
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Update Software

This section describes the procedure to download software that Update Service supports and then
install it.

I:,l—\l Note

When newer versions of Update Service as well as another application is available, performing this procedure
one time updates Update Service only.
To update another application, perform the procedure again.

1. Start your computer.
Update Service also automatically starts.

When it does not start, see "Note" in "Starting Update Service" (P.38).
2.Click the [Configuration] tab, in the [Update Service - Properties] window.

3.1n the [Configuration] tab, configure the following settings.
W For Automatic Notification and Download of Updates
(1) Select [Auto Download and Manually Install Updates].
(2) Set [Start Time] and [Update Intervall.
(3) Click [Apply] or [OK].
When any update has been found until the time set in [Start Time] and [Update Interval], the icon
indicates that and an update package is downloaded.

B For Automatic Notification of Updates Only
(1) Select [Notify Updates Only].
(2) Set [Start Time] and [Update Intervall.
(3) Click [Apply] or [OK].
When any update has been found until the time set in [Start Time] and [Update Interval], the icon
indicates that and an update package is downloaded
M For Disabling Automatic Notification and Download of Updates
(1) Select [Disable Auto Updates].
(2) Click [Apply] or [OK].

4. As necessary, set the options on following tabs in the [Update Service - Properties] window.
To use the default settings, you do not need to change these options.

+ [General] tab

+ [Log] tab

+ [Update Notification] tab
+ [Software Location] tab

-+ [Software to Update] tab

5. When auto-updated software is downloaded, install it in the [Update Service - Update Now] window.
When you select [Notify Updates Only] or [Disable Auto Updates] on the [Configuration] tab or to
immediately apply the update, download the update and install it on the [Update Service - Update
Now] window.

6. Confirm the installation result displayed in the [Run Result] dialog box.
If the installation of any update package failed, proceed to Step 8 after performing Step 7.

/. Close the [Run Result] dialog box.

8. Open the [Update Service - Update Now] window again, select the check boxes for the update
packages that have failed to be installed and then, click [Install].
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Registering Printer with Device Management > Register FUJIFILM Business
Innovation Drivers

This section describes the procedure to register to Update Service the printer drivers and fax drivers
corresponding to the printer registered in Device Management.

1. Start your computer.
Also automatically start Update Service.

When it does not start, see "Note" in "Starting Update Service" (P.38).

2.0n the [Drivers to Update] tab in the [Update Service - Properties] window, select the check box for
the printer driver or fax driver to be registered.

bi\ Note

If clicking the [Drivers to Update] tab does not display the contents, select the [Driver] check box in
[Update Target] of the [Configuration] tab and click [Apply].

3. As necessary, set the options on following tabs in the [Update Service - Properties] window.
To leave the settings as default, you do not need to change these options.

e [General] tab
e [Log]tab
e [Update Notification] tab

e [Driver Location] tab

4. Set the [Configuration] tab in the [Update Service - Properties] window.
B For Periodical Notification and Download of Updates
(1) Select one of the following options.
e [Notify Updates Only]
e [Auto Download and Manually Install Updates]

|,L_|—\| Note

Whichever option you select, the same features are executed for FUJIFILM Business Innovation printer
drivers and fax drivers.

For PostScript drivers, automatic update notification or download is not available whichever option you
select.

For more details, see the table in "[Configuration] tab" (P.27).

(2) Set [Start Time] and [Update Intervall.

(3) Select the check box for [Retrieve Latest Drivers During Auto Update].

(4) Click [Apply] or [OK].
When an update is downloaded at the time set in [Start Time] and [Update Interval], printer drivers
and fax drivers can be downloaded on the [Download Printer Driver] page of ApeosWare
Management Suite.

B For Disabling Periodical Notification and Download of Updates
(1) Select [Disable Auto Updates].
(2) Click [Apply] or [OK].

5.1n the following cases, register printer drivers and fax drivers in the [Update Service - Manage
FUJIFILM Business Innovation Drivers] window.
- To register a PostScript driver
Click [Register From File].
+ To register from the driver CD kit
Click [Register From Media].
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« To immediately update
Click [Register From Website].

|/L—|i\ Note

+ The PostScript driver is not registrable by [Register From Website].

- The ART-EX driver is not registrable by [Register From File].
On the [Download Printer Driver] page of ApeosWare Management Suite, you can now download
printer drivers and fax drivers.

Registering Printer with Device Management > Register Third-Party Drivers

This section describes the procedure to register Third-Party Drivers and fax drivers to Update Service.

I/L_l_“\ Note

Perform this procedure before registering a printer to Device Management.

1. Start your computer.
Also automatically start Update Service.

When it does not start, see "Note" in "Starting Update Service" (P.38).

2.As necessary, set the options on following tabs in the [Update Service - Properties] window.
To use the default settings, you do not need to change these options.

[General] tab
[Log] tab

|,L—|i\ Note

The following features are not available for Third-Party Drivers and fax drivers.
- Search a Website for updates.
- Download a printer driver or a fax driver that has been updated from a Website.

Even if you select [Auto Download and Manually Install Updates] or [Notify Updates Only] on the
[Configuration] tab, this setting is not applied to Third-Party Drivers and fax drivers.

3. Register the driver in the [Update Service - Manage Third-Party Drivers] window.
On the [Download Printer Driver] page of ApeosWare Management Suite, you can now download
printer drivers and fax drivers.

Retrieving Notices from FUJIFILM Business Innovation

This section describes the procedures to retrieve notices from FUJIFILM Business Innovation.

1. Start your computer.
Also automatically start Update Service.

When it does not start, see "Note" in "Starting Update Service" (P.38).

2.Click [Check Latest Information] in the [Update Service - Update Now] window.
Retrieves latest information.

|/L—|i\ Note

To periodically retrieve FUJIFILM Business Innovation notices, select [Auto Download and Manually
Install Updates] or [Notify Updates Only] at Step 4 in Update Software.

Deleting Update Package

Delete unnecessary update package from the storage location.
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1.From the list in the [Update Service - Storage Location Management] window, select the check box
for the update package to be deleted.

2.Click [Delete].
The selected update package is deleted from the storage location.

Backing-up/Restoring Settings and Drivers

This section describes how to backup or restore Update Service settings and printer drivers/fax drivers.

Backing-up Update Service Settings

1. Copy the "{Update Service installation folder}\Update Service\configuration" folder to any location.

Restoring Update Service Settings

1. Open the "{Update Service installation folder}\Update Service\configuration" folder in the server in
which Update Service is to be restored.

2. Copy the following files in the folder with Update Service settings backed-up and overwrite them to
the folder above mentioned.
+ AccessSetting.xml
- DriverSiteSetting.xml
+ GeneralSetting.xml
- LogSetting.xml
- NoticeSetting.xml
+ ScheduleSetting.xml
+ UpdateObjectSetting.xml

Backing-up Printer Drivers or Fax Drivers

1. Copy the "{Folder with Update Service modules}\Update Service\DriverData" folder to any location.

Restoring Printer Drivers or Fax Drivers

1. Open the "{Folder with Update Service modules}\Update Service\DriverData" folder in the server in
which a printer driver or a fax driver is to be restored.

2.Copy all the contents in the backup folder of a printer driver or a fax driver to the folder above
mentioned.

Icons

The icon for Update Service is displayed in the Task Tray.
is displayed when no notification is incoming, and is displayed when a notification is incoming.
Describes the contents of the menu, balloon tip, tool tip for each icon and the right-click contents.

(Update Service) Icon
This is displayed when no notification is incoming.
No balloon tip is displayed.
[Update Service] is displayed in the tool tip.
e Right-Click Menu
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+ Update Now
The [Update Service - Update Now] window is displayed.
When the [Update Service - Properties] window or the [Update Service - Storage Location
Management] window is displayed, [Update Now] cannot be clicked.

lil—\\ Note

Even if the icon is double-clicked, the [Update Service - Update Now] window will be displayed.

Properties

The [Update Service - Properties] window is displayed.

When the [Update Service - Update Now] window or the [Update Service - Storage Location
Management] window is displayed, [Properties] cannot be clicked.

Storage Location Management

The [Update Service - Storage Location Management] window is displayed.

When the [Update Service - Properties] window or [Update Service - Update Now] window is
displayed, [Storage Location Management] cannot be clicked.

Manage Drivers
This menu is displayed only when Update Service is installed in the Server mode.

The [Update Service - Manage FUJIFILM Business Innovation Drivers] window is displayed.

+ Manage Third-Party Drivers
This menu is displayed only when Update Service is installed in the Server mode.
The [Update Service - Manage Third-Party Drivers] window is displayed.

+ About
The [About] window is displayed.
Help
This Help is displayed.

+ Exit
Update Service exits.

Icon

This is displayed when a notification is incoming.
e Displayed Contents and Right-Click Behavior

Balloon Tip

Tool Tip

Right-Click or Double-Click Behavior

Latest Information Check
Complete

Newly arrived FUJIFILM
Business Innovation notice
available.

You can check its details on the
ApeosWare Management Suite
portal.

Latest information check
result

A message box displays:

"Newly arrived FUJIFILM Business Innovation
notice available.

You can check its details on the ApeosWare
Management Suite portal.”

Latest Information Check
Complete

The check for latest information
has completed.

To download the latest
information, click this icon.

Latest Information
Incoming

The [Update Service - Update Now] window
is displayed.

However, this is not displayed when the
[Update Service - Properties] window or
[Update Service - Storage Location
Management] window is displayed.
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Downloading Complete
Downloading of the latest
information has completed.
To install, click this icon.

Download result

The [Update Service - Update Now] window
is displayed.
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Balloon Tip Tool Tip Right-Click or Double-Click Behavior
Driver Registration Complete Driver Registration « When multiple drivers are registered
Register driver to Update Result The [FUJIFILM Business Innovation Driver
Service. Registration Result] dialog box is displayed.

+ When no driver is registered
A message box displays:
"If there are no applicable latest drivers in
the driver registration result, or no
applicable driver selected on the [Drivers to
Update] tab in Properties, the operation will
end without any action taken."

Auto Update Error Auto update failure A message box displays the cause of the error.
An auto update failed.

Driver Registration Canceled Driver Registration A message box displays:

No drivers to update are Cancellation No driver will be registered as no driver to
selected. update is selected.

e Right-Click Menu

Show Notification

The same content is displayed as "Right-Click or Double-Click Behavior" in "Displayed Contents
and Right-Click Behavior".

Delete All Notifications

"Do you want to delete all {number of notifications} notification messages?" is displayed.
Clicking [Yes] deletes all the notifications saved.

Windows

Update Service - Update Now
Display this by performing any of the following operations.
e Right-click the Update Service icon on the task tray, and then click [Update Now].

e Select [FUJIFILM ApeosWare Management Suite] > [Update Service] > [Update Service - Update
Now] in this order from the menu which makes Windows programs start.

When the [Update Service - Properties] window or the [Update Service - Storage Location
Management] window is displayed, [Update Now] cannot be clicked.

Checks the latest information in the access destination and allows you to download the update package
and then install it.

Different update package is provided for each software version.

Download Target List
e [Check Latest Information]

Checks the latest information in the access destination and displays a list of update-use packages to
be targeted for downloading.

Clicking this also downloads the notices from FUJIFILM Business Innovation.

I:,lj Note

- Confirm the details of notices on the [Portal] page of ApeosWare Management Suite.

- Latest information may appear on the [Portal] page even if an error occurs during the retrieval of latest
information.

e Retrieval Location
The URL set with [Retrieval Location] of the [Software Location] tab is displayed.
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o List
Select the check box for the update package to be downloaded.

[Download]
Downloads the update package selected in [Download Target List].
When installation completes, the result is displayed in the [Run Result] dialog box.

Installation List

e Storage Location
The folder path set in [Module Storage Folder] during the installation of Update Service is displayed.
The update package downloaded is stored in this location.

o List
Non-installed packages of a newer version than the installed software are displayed.
Select the check box for the update package to be installed.

[Install]

Installs the update package selected in [Installation List].
When installation completes, the result is displayed in the [Run Result] dialog box.

LL_|_\\ Note

Installed packages are deleted from the installation list. Even if an earlier version is reinstalled, the packages
are not displayed in the list again.

[Close]
Closes the window.

Update Service - Properties
Display by performing any of the following procedures.
e Right-click the Update Service icon on the task tray, and then click [Properties].

e Select [FUJIFILM ApeosWare Management Suite] > [Update Service] > [Update Service - Properties]
in this order from the menu which makes Windows programs start.

When the [Update Service - Update Now] window or the [Update Service - Storage Location
Management] window is displayed, [Properties] cannot be clicked.

This window consists of the following tabs and buttons:

Tabs
o [General] tab
e [Log]tab
e [Configuration] tab
e [Update Notification] tab
e [Software Location] tab
e [Software to Update] tab
e [Driver Location] tab
e [Drivers to Update] tab

If Update Service was installed in Client Mode, the [Driver Location] and [Drivers to Update] tabs will
not be displayed.

[OK]
Saves the content set, and closes this window.
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[Cancel]
Cancels the content set, and closes this window.

[Apply]
Applies the content set.

[Help]
Displays this help.

[General] tab

Set the general properties.

Display Icon on Task Tray
Select whether to display the icon on the task tray.
e Display
Displays the icon on the task tray.
This is selected by default.

e Hide (Display temporarily when update result is received)
Hides the icon on the task tray.

Installer Run Mode
Select the execution mode when installing.

e Silent Mode (Run in Conversation Mode when conversation is required)
Installation is performed with no dialog box displayed.
You do not need to enter each item.
However, when entry is required, the feature is executed in conversation mode regardless of this
setting.
This is selected by default.

e Conversation Mode
Installs in conversation mode.
The dialog box is displayed and you need to enter each item as necessary to install.

[Log] tab

Specify the save period for logs and confirm the storage location.

Retention Period
Select the save period from [90 days], [180 days], [360 days], or [Do Not Delete].
The default value is [360 days].

Storage Location
Specify the location at which to store logs.

|£I_\| Note

When other than [Do Not Delete] is selected for the save period, log files created at a file creation date that
is older from the current date than the save period are deleted . The log files are deleted when a new log file
is created.

[Configuration] tab

Set which items to update and how to perform updates.
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Update Target

Displayed when Update Service is installed in Server Mode. Not displayed when installed in Client Mode.
e Software

To set software to automatically be updated, select this check box.
e Driver
To set printer drivers and fax drivers to automatically be updated, select this check box.

When Update Service is installed in Client Mode, software is always updated automatically. Printer
drivers and fax drivers are never automatically updated.

Auto Update Settings

Select one of the following auto-update methods.
e Disable Auto Updates

e Notify Updates Only

e Auto Download and Manually Install Updates

The following table shows which features are executed for different targets when you select each of the
options above.

X : Executed feature
- : Unexecuted feature

Target
Software | [T Busiess
Disable Auto Updates Update Notification - -
Download - -
Install - -
Notify Updates Only* Update Notification X X
Download - X
Install - -
Auto Download and Manually | Update Notification X X
Install Updates Download » »
Install - -

* This is selected by default.

Start Time

When you select [Notify Updates Only] or [Auto Download and Manually Install Updates], specify the
time to check, with the following procedures.

e Hour(s)
Select from [0] to [23], on an 1-hour block basis.
e Minute(s)
Select from [00] to [55], on a 5-minute block basis.

Update Interval
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When you select [Notify Updates Only] or [Auto Download and Manually Install Updates], select the
interval to check.
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e Daily
Checks every day.
o Weekly
This is selected by default.
Specify the day of the week to check the updates.
e Monthly
Select the date to check the updates.
If the selected date is later than the end date of the month to check, the end date is enabled.

Retrieve Latest Drivers During Auto Update
This notification is displayed only when you installed Update Service in Server Mode.
When you add a printer using Device Management, select this check box to register the driver.
This is deselected by default.

[Update Notification] tab

When you select [Notify Updates Only] or [Auto Download and Manually Install Updates] on the
[Configuration] tab, set the condition and method to notify the result of the check or download.

I/L_l_“\ Note

When [Disable Auto Updates] is selected on the [Configuration] tab, the setting configured here is disabled.

Notification Conditions
Select the notification condition.
All the check boxes are selected by default.
o Notify Latest Check Result

Notifies the check results of updates.
e Notify Download Result
Notifies the results of downloading.
e Notify Driver Update Result
This option is displayed only when you install Update Service in Server Mode.

Notifies the result of downloading a printer driver or a fax driver.

Reminder
Select the notification method of the execution result selected for notification conditions.
e Notify Once Only
Notifies only one time.
¢ Notify Repeatedly
Notifies repeatedly at the specified interval.
Clicking balloon tips of Icons stops notification.
Notification starts again after it is updated.
This is selected by default.

|,L—|i\ Note

When [Notify Repeatedly] is selected, only the execution results are notified regardless of the setting of
auto update.
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e Interval

Select the interval at which to notify repeatedly from [10 min], [30 min], [1 hour], [2 hours], [0.5 day],
[1 day], [2 days], [1 week], and [2 weeks].

The default value is [10 minutes].

[Software Location] tab

When Update Service is installed in Server Mode, selecting the [Software] check box in [Auto Update
Settings] of the [Configuration] tab displays the content of this tab.

When Update Service is installed in Client Mode, the content of this tab is always displayed.
Specify the source from which to retrieve the latest information.

Retrieval Target

Specify the location from which to retrieve the latest information.

e Get Latest Information From FUJIFILM Business Innovation Website
This option is displayed only when you install Update Service in Server Mode.
Retrieves the latest information from the FUJIFILM Business Innovation website.
This is selected by default.

e Get Latest Information From Server's Storage Location
Retrieves the latest information from the storage location in the server.
This is selected by default.

- URL
The URL of FUJIFILM Business Innovation (http://opencds-fb.fujifilm.com/gen/
aw_suite_aux/softwareupdate/awms/) is entered by default.

Proxy Server
Select this check box when you use a proxy server, and specify the following items.

[Proxy Server Settings]
If [Proxy Server Settings] is clicked, the dialog box is displayed.
e Get Latest Information From Shared Folder or Media
Downloads latest information from a shared folder or a media.

Folder Name
Enter the shared folder name or local folder name (path).

You can enter O to 260 single-byte alphanumeric characters.
[Browse]
If [Browse] is clicked, the folder can be specified.

+ Use Account
Select this check box when you use an account, and specify the following items.

+ Account Name

Enter the account name.

You can enter from 0O to 256 single-byte alphanumeric characters.
- Password

Enter the password for the account.

You can enter from 0O to 256 single-byte alphanumeric characters.

30



Installing in Server Mode

|,L—|i\ Note

When you specify a shared folder at the retrieval location and use an account, select whether you can
access the specified folder with the entered account name and password.

If you can access even without entering the account name and password, the entered account name and
password are disabled. An error occurs when access to the folder fails.

[Software to Update] tab

When Update Service is installed in Server Mode, selecting the check box for [Software] of [Auto Update
Settings] in the [Configuration] tab displays the content of this tab.

When Update Service is installed in Client Mode, the content of this tab is always displayed.
Select software to be automatically updated.

List of Target Software
Lists the software that Update Service supports.
Select this check box for software to be automatically updated.
The check boxes for all software are selected by default.

[Driver Location] tab

When Update Service is installed in Server Mode, selecting [Driver] in the [Auto Update Settings] of the
[Configuration] tab displays the contents in this tab.

When Update Service is installed in Client Mode, this tab will not be displayed.
Specify the location from which to retrieve the driver.

Downloads the driver from the corresponding Web site of FUJIFILM Business Innovation.
e URL
Displays the URL of the FUJIFILM Business Innovation site from which to retrieve the driver.
e Proxy Server
Select this check box when you use a proxy server, and specify the following items.
[Proxy Server Settings]
Displays the [Proxy Server Settings] dialog box

[Drivers to Update] tab

When Update Service is installed in Server Mode, selecting [Driver] in the [Auto Update Settings] of the
[Configuration] tabdisplays the contents in this tab.

When Update Service is installed in Client Mode, this tab will not be displayed.

List
Select the check box for the FUJIFILM Business Innovation driver to be registered to Update Service.
This is deselected by default.
e Driver Name
The driver name is displayed.
e Architecture
Drivers for 32-bit systems will be displayed as [32-bit].
Drivers for 64-bit systems will be displayed as [64-bit].
e lLanguage

The language to which the driver corresponds is displayed.
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[Select All]
Selects all of the items displayed in the list.

[Deselect All]
Deselects all of the items displayed in the list.

Update Service - Storage Location Management

To display this, right-click the Update Service icon on the task tray and then click [Storage Location
Management].

When the [Update Service - Properties] window or the [Update Service - Update Now] window is
displayed, [Storage Location Management] cannot be clicked.

Displays and deletes update-use packages saved at the storage location.

Storage Location

The folder path set in [Module Storage Folder] during the installation of Update Service is displayed.
List

Displays the update packages saved in [Storage Location].

e Implementation Status

[Installation] is displayed when Update Service is used and installation completes, and [Download] is
displayed otherwise.

l:,l—\l Note

When you have executed such as installation with other than Update Service, the list content is not
updated.

e Date Implemented

Displays the last date on which downloading or installation was executed using Update Service.
e Software Name

Displays the software name of the update-use package.
e Version

Displays the version of the update package.

[Select All]
Selects all of the items displayed in the list.

[Deselect All]
Deselects all of the items displayed in the list.

[Delete]
Deletes the selected update packages.

‘:||—\| Note

When you delete packages of a client tool from a server, the client computer cannot download those
packages.

[Close]
Closes the window.
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Update Service - Manage FUJIFILM Business Innovation Drivers
Display this by performing any of the following operations.
e Right-click the Update Service icon on the task tray and then click [Manage driver].

e Select [Start] > [Programs] > [FUJIFILM ApeosWare Management Suite] > [Update Service] >
[Update Service Driver Management].

Ll_l_“\ Note

If it is still not displayed, select the [Driver] check box in the [Software to Update] of the [Configuration] tab
and click [Apply].
Registers FUJIFILM Business Innovation printer drivers and fax drivers.
Driver Registration List
Select the method for registering printer drivers and fax drivers.

Ll_l_“\ Note

+ Some printer drivers and fax drivers cannot be registered from the FUJIFILM Business Innovation website.
To register those drivers, execute [Register From Media] for the driver CD kit attached to the device whose
driver cannot be registered.

+ When registration completes, confirm that the version of the driver is displayed in [Version].
e [Register From File]

Click this to register a PostScript driver.

Specify a PostScript driver in your computer.

Click this to display the [Register FUJIFILM Business Innovation Driver (Register From File)] dialog box.
e [Register from Media]

Registers printer drivers and fax drivers from the CD inserted into the CD or DVD drive.

Click this to display the [Register FUJIFILM Business Innovation Driver (Register From Media)] dialog
box.

Iﬁl—\\ Note

The completion of registration takes time. Also, it cannot be stopped in progress.
The computer cannot be shut down during registration.
e [Register From Website]

Downloads printer drivers and fax drivers from the FUJIFILM Business Innovation website and
registers them.

|,l_|—“| Note

The completion of processing takes time depending on your network environment and the number of
driver registrations.

List

FUJIFILM Business Innovation printer drivers and fax drivers are displayed.

e Driver Name
The names of printer drivers and fax drivers are displayed.

e Version
The versions of the printer drivers and fax drivers registered in Update Service are displayed.
When version information is not available, "-" is displayed.
For printer drivers and fax drivers not registered in Update Service, "Not Registered" is displayed.
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e Architecture
Drivers for 32-bit systems will be displayed as [32-bit].
Drivers for 64-bit systems will be displayed as [64-bit].
e language

The languages to which each printer driver and fax driver corresponds are displayed.

[Close]
Closes the window.

Update Service - Manage Third-Party Drivers

To display this, right-click the Update Service icon on the task tray and then click [Manage Third-Party
Drivers].

|£|_\\ Note

If it is still not displayed, select the [Driver] check box in the [Software to Update] of the [Configuration] tab
and click [Apply].

Registers Third-Party Drivers and fax drivers to Update Service.
[Registration]
Click this to display the [Third-Party Drivers Registration] dialog box.

‘:||—\| Note

When registration completes, confirm in [Driver Registration List] that registration succeeded.

Driver Registration List
The Third-Party Drivers and fax drivers that have been already registered are displayed.

[Select All]
Selects all of the items displayed in the list.

[Deselect All]
Deselects all of the items displayed in the list.

[Delete]
Deletes the printer drivers and fax drivers selected.

[Close]
Closes the window.

About
To display this, right-click the Update Service icon on the task tray and then click [About].

Displays the version information of your Update Service.

[Close]
Closes the window.

Selecting [Register From File] or [Register From Media] on the [Update Service - Manage FUJIFILM
Business Innovation Drivers] window does not display this dialog box.

34



Installing in Server Mode

Help

To display this, right-click the Update Service icon on the task tray and then click [Help].
This help is displayed.

Dialog Boxes

Proxy Server Settings

Set whether to use Proxy Server to retrieve latest information.When you set to use it, also configure the
settings to connect your Proxy Server and set the authentication method.

To display this dialog box, click [Proxy Server Settings] in the [Software Location] tab or [Driver Location]
tab of the [Update Service - Properties] window.

Use Proxy Server
To use Proxy Server, select this check box and set the following options.
e Address

Enter an IPv4 address, IPv6 address or a valid DNS address.
You can enter from 0 to 256 single-byte alphanumeric characters.
e Port
Enter a port number.
You can enter any number from 1 to 65535.
e Use Proxy Authentication
To use the proxy authentication, select this check box and set the following options.

+ User Name
Enter a user name for your proxy server.

You can enter from O to 256 single-byte alphanumeric characters.

Password
Enter the password for your proxy server.

You can enter from O to 256 single-byte alphanumeric characters.

[OK]
Saves the content set, and closes the dialog box.

[Cancel]
Cancels the content set, and closes the dialog box.

Progress Status

This is displayed when processing starts, and closes when processing completes.

[Cancel]
Cancels processing in progress.

Run Result

Displays the execution results of the check, download, or installation of updates.

[Close]
Closes the dialog box.
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Confirm

This dialog box is displayed before the beginning of the installation, or before the deletion of the update
package from [Update Service - Storage Location Management].

The items displayed in the list are targeted for processing.

[Yes]
Executes processing during operation.

[No]
Cancels the operation, and closes this dialog box.

Register FUJIFILM Business Innovation Driver (Register From File)

Register the FUJIFILM Business Innovation PostScript driver using a driver file.

Clicking [Register From File] on the [Update Service - Manage FUJIFILM Business Innovation Drivers]
window displays this dialog box.

Driver Type
[PostScript Driver] is displayed.

Retrieval Location
Specify the location from which to retrieve the driver.
You can enter from 0 to 260 single-byte alphanumeric characters.

[Browse]

From the displayed dialog box for specifying the driver files, specify the source from which to retrieve
the driver files.

[OK]
Registers the PostScript driver. When registration completes, the [FUJIFILM Business Innovation Driver
Registration Result] dialog box is displayed.

[Cancel]
Cancels the operation, and closes this dialog box.

Register FUJIFILM Business Innovation Driver (Register From Media)

Register FUJIFILM Business Innovation printer drivers and fax drivers using the "driver CD kit".

Clicking [Register From Media] on the [Update Service - Manage FUJIFILM Business Innovation Drivers]
window displays this dialog box.

Drive
Select the drive in which the CD is inserted.

[OK]
Registers printer drivers and fax drivers. When registration completes, the [FUJIFILM Business
Innovation Driver Registration Result] dialog box is displayed.

[Cancel]
Cancels the operation, and closes this dialog box.
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Third-Party Drivers Registration

Register a driver other than FUJIFILM Business Innovation using a driver file.

Clicking the [Register] button on the [Update Service - Manage Third-Party Drivers] window displays
this.

LL_|_\\ Note

When the specified driver already is registered, it is registered again.

Target Operating System
Select the check box for the target OS of a driver.

Retrieval Location
Specify the location from which to retrieve the driver.
You can enter from 0 to 260 single-byte alphanumeric characters.

[Browse]
In the [Open] dialog box displayed, specify the source from which to retrieve the driver files.

[OK]

Registers printer drivers and fax drivers. When registration completes, the [Third-Party Drivers
Registration Result] dialog box is displayed.

[Cancel]
Cancels the operation, and closes this dialog box.

FUJIFILM Business Innovation Driver Registration Result

Displays the registration results of FUJIFILM Business Innovation printer drivers and fax drivers.

Ll_l_“\ Note

When a malfunction occurs during driver registration, the registration result may not be correctly displayed.
Definitely confirm it on the [FUJIFILM Business Innovation Driver Management] window.

[Close]
Closes the dialog box.

Third-Party Drivers Registration Result

The registration result of the Third-Party Drivers and fax drivers are displayed.

[Close]
Closes the dialog box.
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Installing in Client Mode

Operation Procedures

Starting/Exiting Update Service

Starting Update Service

1. Start your computer and log in as a user with Administrators permissions.
Update Service also starts automatically and the icon is displayed on the task tray.

l/L—'i\ Note

+ When Update Service does not start, or when restarting after exiting Update Service, select [FUJIFILM
ApeosWare Management Suite] > [Update Service] > [Update Service - Update Now] in this order from
the menu which makes Windows programs start.

+ Theicon is displayed by default, but it is not displayed when [Hide (Display temporarily when update
result is received)] on the [General] tab is selected.

The following two types of icons are displayed on the task tray.
. (No Notification Incoming)

(Notification Incoming)
For details of the icons, see "lcon" (P.24).

Exiting Update Service

1.Right-click the (Not receiving Update Notification) icon.

2.Select [Exit] from the menu.
Update Service exits.

Update Software

This section describes the procedure to download software that Update Service supports and then
install it.

‘:||—\| Note

When newer versions of Update Service as well as another application is available, performing this procedure
one time updates Update Service only.
To update another application, perform the procedure again.

1. Start your computer.
Update Service also automatically starts.

When it does not start, see "Note" in "Starting Update Service" (P.38).
2.Click the [Configuration] tab in the [Update Service - Properties] window.

3.1n the [Configuration] tab, configure the following settings.
M For Automatic Notification and Download of Updates
(1) Select [Auto Download and Manually Install Updates].
(2) Set [Start Time] and [Update Intervall.
(3) Click [Apply] or [OK].
When any update has been found until the time set in [Start Time] and [Update Interval], the icon
indicates that and an update package is downloaded.
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W For Automatic Notification of Updates Only
(1) Select [Notify Updates Only].
(2) Set [Start Time] and [Update Intervall.

(3) Click [Apply] or [OK].
When any update has been found until the time set in [Start Time] and [Update Interval], the icon
indicates that and an update package is downloaded

M For Disabling Automatic Notification and Download of Updates
(1) Select [Disable Auto Updates].
(2) Click [Apply] or [OK].

4. As necessary, set the options on following tabs in the[Update Service - Properties] window.
To use the default settings, you do not need to change these options.

+ [General] tab

+ [Log] tab

+ [Update Notification] tab
+ [Software Location] tab

-+ [Software to Update] tab

5. When auto-updated software is downloaded, install it in the [Update Service - Update Now] window.
When you select [Notify Updates Only] or [Disable Auto Updates] on the[Configuration] tab or to
immediately apply the update, download the update and install it on the [Update Service - Update
Now] window.

6. Confirm the installation result displayed in the [Run Result] dialog box.
If the installation of any update package failed, proceed to Step 8 after performing Step 7.

7.Close the [Run Result] dialog box.

8. Open the [Update Service - Update Now] window again, select the check boxes for the update
packages that have failed to be installed and then, click [Install].
Deleting Update Package

Delete unnecessary update package from the storage location.

1.From the list in the [Update Service - Storage Location Management] window, select the check box
for the update package to be deleted.

2.Click [Delete].
The selected update package is deleted from the storage location.

Icons

Icons
The icon for Update Service is displayed in the Task Tray.
is displayed when no notification is incoming, and is displayed when a notification is incoming.
Describes the contents of the menu, balloon tip, tool tip for each icon and the right-click contents.

(Update Service) Icon
This is displayed when no notification is incoming.
No balloon tip is displayed.
[Update Service] is displayed in the tool tip.
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e Right-Click Menu

Update Now
The [Update Service - Update Now] window is displayed.

When the [Update Service - Properties] window or the [Update Service - Storage Location
Management] window is displayed, [Update Now] cannot be clicked.

I:,lj Note

Even if the icon is double-clicked, the [Update Service - Update Now] window will be displayed.
Properties

The [Update Service - Properties] window is displayed.

When the [Update Service - Update Now] window or the [Update Service - Storage Location
Management] window is displayed, [Properties] cannot be clicked.

Storage Location Management

The [Update Service - Storage Location Management] window is displayed.

When the [Update Service - Properties] window or [Update Service - Update Now] window is
displayed, [Storage Location Management] cannot be clicked.

Manage Drivers
This menu is displayed only when Update Service is installed in the Server mode.

The [Update Service - Manage FUJIFILM Business Innovation Drivers] window is displayed.
Manage Third-Party Drivers
This menu is displayed only when Update Service is installed in the Server mode.
The [Update Service - Manage Third-Party Drivers] window is displayed.

+ About
The [About] window is displayed.
Help
This Help is displayed.

« Exit
Update Service exits.

Icon

This is displayed when a notification is incoming.

e Displayed Contents and Right-Click Behavior

Balloon Tip

Tool Tip

Right-Click or Double-Click Behavior

Latest Information Check
Complete

Newly arrived FUJIFILM
Business Innovation notice
available.

You can check its details on the
ApeosWare Management Suite
portal.

Latest information check
result

A message box displays:

"Newly arrived FUJIFILM Business Innovation
notice available.

You can check its details on the ApeosWare
Management Suite portal.”

Latest Information Check
Complete

The check for latest information
has completed.

To download the latest
information, click this icon.

Latest Information
Incoming

The [Update Service - Update Now] window
is displayed.

However, this is not displayed when the
[Update Service - Properties] window or
[Update Service - Storage Location
Management] window is displayed.
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Downloading Complete
Downloading of the latest
information has completed.
To install, click this icon.

Download result

The [Update Service - Update Now] window
is displayed.
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Balloon Tip Tool Tip Right-Click or Double-Click Behavior
Driver Registration Complete Driver Registration « When multiple drivers are registered
Register driver to Update Result The [FUJIFILM Business Innovation Driver
Service. Registration Result] dialog box is displayed.

+ When no driver is registered
A message box displays:
"If there are no applicable latest drivers in
the driver registration result, or no
applicable driver selected on the [Drivers to
Update] tab in Properties, the operation will
end without any action taken."

Auto Update Error Auto update failure A message box displays the cause of the error.
An auto update failed.

Driver Registration Canceled Driver Registration A message box displays:

No drivers to update are Cancellation No driver will be registered as no driver to
selected. update is selected.

e Right-Click Menu

Show Notification

The same content is displayed as "Right-Click or Double-Click Behavior" in "Displayed Contents
and Right-Click Behavior".

Delete All Notifications

"Do you want to delete all {number of notifications} notification messages?" is displayed.
Clicking [Yes] deletes all the notifications saved.

Window
Update Service - Update Now

Display this by performing any of the following operations.
e Right-click the Update Service icon on the task tray, and then click [Update Now].

e Select [FUJIFILM ApeosWare Management Suite] > [Update Service] > [Update Service - Update
Now] in this order from the menu which makes Windows programs start.

When the [Update Service - Properties] window or the [Update Service - Storage Location
Management] window is displayed, [Update Now] cannot be clicked.

Checks the latest information in the access destination and allows you to download the update package
and then install it.

Different update package is provided for each software version.

Download Target List
e [Check Latest Information]

Checks the latest information in the access destination and displays a list of update-use packages to
be targeted for downloading.

Clicking this also downloads the notices from FUJIFILM Business Innovation.

I:,lj Note

- Confirm the details of notices on the [Portal] page of ApeosWare Management Suite.

- Latest information may appear on the [Portal] page even if an error occurs during the retrieval of latest
information.

e Retrieval Location

The URL set with [Retrieval Location] of the [Software Location] tab is displayed.
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o List
Select the check box for the update package to be downloaded.

[Download]
Downloads the update package selected in [Download Target List].
When installation completes, the result is displayed in the [Run Result] dialog box.

Installation List
e Storage Location
The folder path set in [Module Storage Folder] during the installation of Update Service is displayed.
The update package downloaded is stored in this location.
e List
Non-installed packages of a newer version than the installed software are displayed.

Select the check box for the update package to be installed.

[Install]
Installs the update package selected in [Installation List].
When installation completes, the result is displayed in the [Run Result] dialog box.

|/L_|i\ Note

Installed packages are deleted from the installation list. Even if an earlier version is reinstalled, the packages
are not displayed in the list again.

[Close]
Closes the window.

Update Service - Properties
Display by performing any of the following procedures.
e Right-click the Update Service icon on the task tray, and then click [Properties].

e Select [FUJIFILM ApeosWare Management Suite] > [Update Service] > [Update Service - Properties]
in this order from the menu which makes Windows programs start.

When the [Update Service - Update Now] window or the [Update Service - Storage Location
Management] window is displayed, [Properties] cannot be clicked.

This window consists of the following tabs and buttons:

Tabs
o [General] tab
e [Log]tab
e [Configuration] tab
e [Update Notification] tab
e [Software Location] tab
e [Software to Update] tab
e [Driver Location] tab
e [Drivers to Update] tab

If Update Service was installed in Client Mode, the [Driver Location] and [Drivers to Update] tabs will
not be displayed.
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[OK]
Saves the content set, and closes this window.

[Cancel]
Cancels the content set, and closes this window.

[Apply]
Applies the content set.

[Help]
Displays this help.

[General] tab

Set the general properties.

Display Icon on Task Tray

Select whether to display the icon on the task tray.

e Display
Displays the icon on the task tray.
This is selected by default.

e Hide (Display temporarily when update result is received)

Hides the icon on the task tray.

Installer Run Mode
Select the execution mode when installing.

e Silent Mode (Run in Conversation Mode when conversation is required)
Installation is performed with no dialog box displayed.

You do not need to enter each item.

Installing in Client Mode

However, when entry is required, the feature is executed in conversation mode regardless of this

setting.
This is selected by default.

e Conversation Mode
Installs in conversation mode.

The dialog box is displayed and you need to enter each item as necessary to install.

[Log] tab

Specify the save period for logs and confirm the storage location.

Retention Period

Select the save period from [90 days], [180 days], [360 days], or [Do Not Delete].

The default value is [360 days].

Storage Location
Specify the location at which to store logs.

Cllj Note

When other than [Do Not Delete] is selected for the save period, log files created at a file creation date that
is older from the current date than the save period are deleted . The log files are deleted when a new log file

is created.
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[Configuration] tab

Set which items to update and how to perform updates.

Update Target

Displayed when Update Service is installed in Server Mode. Not displayed when installed in Client Mode.
e Software

To set software to automatically be updated, select this check box.
e Driver

To set printer drivers and fax drivers to automatically be updated, select this check box.

When Update Service is installed in Client Mode, software is always updated automatically. Printer
drivers and fax drivers are never automatically updated.

Auto Update Settings

Select one of the following auto-update methods.
e Disable Auto Updates

e Notify Updates Only

¢ Auto Download and Manually Install Updates

The following table shows which features are executed for different targets when you select each of the
options above.

x : Executed feature
- : Unexecuted feature

Target
Software | [N Buiness
Disable Auto Updates Update Notification - -
Download - -
Install - -
Notify Updates Only* Update Notification X X
Download - X
Install - -
Auto Download and Manually | Update Notification X X
Install Updates Download X X
Install - -

* This is selected by default.

Start Time
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When you select [Notify Updates Only] or [Auto Download and Manually Install Updates], specify the
time to check, with the following procedures.

e Hour(s)
Select from [0] to [23], on an 1-hour block basis.
o Minute(s)
Select from [00] to [55], on a 5-minute block basis.
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Update Interval

When you select [Notify Updates Only] or [Auto Download and Manually Install Updates], select the
interval to check.

e Daily

Checks every day.
o Weekly

This is selected by default.

Specify the day of the week to check the updates.
e Monthly

Select the date to check the updates.

If the selected date is later than the end date of the month to check, the end date is enabled.

Retrieve Latest Drivers During Auto Update
This notification is displayed only when you installed Update Service in Server Mode.
When you add a printer using Device Management, select this check box to register the driver.
This is deselected by default.

[Update Notification] tab

When you select [Notify Updates Only] or [Auto Download and Manually Install Updates] on the
[Configuration] tab, set the condition and method to notify the result of the check or download.

C,I—\l Note

When [Disable Auto Updates] is selected on the [Configuration] tab, the setting configured here is disabled.

Notification Conditions
Select the notification condition.
All the check boxes are selected by default.
¢ Notify Latest Check Result

Notifies the check results of updates.
e Notify Download Result
Notifies the results of downloading.
e Notify Driver Update Result
This option is displayed only when you install Update Service in Server Mode.

Notifies the result of downloading a printer driver or a fax driver.

Reminder
Select the notification method of the execution result selected for notification conditions.
e Notify Once Only
Notifies only one time.
¢ Notify Repeatedly
Notifies repeatedly at the specified interval.
Clicking balloon tips of Icons stops notification.
Notification starts again after it is updated.

This is selected by default.
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|/L—|i\ Note

When [Notify Repeatedly] is selected, only the executed results are notified regardless of the setting of
auto update.

e Interval

Select the interval at which to notify repeatedly from [10 min], [30 min], [1 hour], [2 hours], [0.5 day],
[1 day], [2 days], [1 week], and [2 weeks].

The default value is [10 minutes].

[Software Location] tab

When Update Service is installed in Server Mode, selecting the [Software] check box in [Auto Update
Settings] of the [Configuration] tab displays the content of this tab.

When Update Service is installed in Client Mode, the content of this tab is always displayed.
Specify the source from which to retrieve the latest information.

Retrieval Target
Specify the location from which to retrieve the latest information.
e Get Latest Information From FUJIFILM Business Innovation Website

This option is displayed only when you install Update Service in Server Mode.
Retrieves the latest information from the FUJIFILM Business Innovation website.
This is selected by default.

e Get Latest Information From Server's Storage Location
Retrieves the latest information from the storage location in the server.
This is selected by default.

- URL
The URL of FUJIFILM Business Innovation (https://www.fujifilm.com/fb/softwareupdate/
awms/) is entered by default.

Proxy Server
Select this check box when you use a proxy server, and specify the following items.

[Proxy Server Settings]
If [Proxy Server Settings] is clicked, the dialog box is displayed.
e Get Latest Information From Shared Folder or Media
Downloads latest information from a shared folder or a media.

Folder Name
Enter the shared folder name or local folder name (path).

You can enter O to 260 single-byte alphanumeric characters.
[Browse]
If [Browse] is clicked, the folder can be specified.

+ Use Account
Select this check box when you use an account, and specify the following items.

+ Account Name
Enter the account name.
You can enter from 0O to 256 single-byte alphanumeric characters.
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- Password
Enter the password for the account.
You can enter from 0O to 256 single-byte alphanumeric characters.

lil—\\ Note

When you specify a shared folder at the retrieval location and use an account, select whether you can
access the specified folder with the entered account name and password.

If you can access even without entering the account name and password, the entered account name and
password are disabled. An error occurs when access to the folder fails.

[Software to Update] tab

When Update Service is installed in Server Mode, selecting the check box for [Software] of [Auto Update
Settings] in the [Configuration] tab displays the content of this tab.

When Update Service is installed in Client Mode, the content of this tab is always displayed.
Select software to be automatically updated.

List of Target Software
Lists the software that Update Service supports.
Select this check box for software to be automatically updated.
The check boxes for all software are selected by default.

Update Service - Storage Location Management

To display this, right-click the Update Service icon on the task tray and then click [Storage Location
Management].

When the [Update Service - Properties] window or the [Update Service - Update Now] window is
displayed, [Storage Location Management] cannot be clicked.

Displays and deletes update-use packages saved at the storage location.

Storage Location
The folder path set in [Module Storage Folder] during the installation of Update Service is displayed.

List
Displays the update packages saved in [Storage Location].
e Implementation Status

[Installation] is displayed when Update Service is used and installation completes, and [Download] is
displayed otherwise.

I/L—Ii\ Note

When you have executed such as installation with other than Update Service, the list content is not
updated.

e Date Implemented

Displays the last date on which downloading or installation was executed using Update Service.
e Software Name

Displays the software name of the update-use package.
e Version

Displays the version of the update package.

[Select All]
Selects all of the items displayed in the list.
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[Deselect All]
Deselects all of the items displayed in the list.

[Delete]
Deletes the selected update packages.

C,Iil Note

When you delete packages of a client tool from a server, the client computer cannot download those
packages.
[Close]
Closes the window.

About

To display this, right-click the Update Service icon on the task tray and then click [About].
Displays the version information of your Update Service.

[Close]
Closes the window.

Selecting [Register From File] or [Register From Media] on the [Update Service - Manage FUJIFILM
Business Innovation Drivers] window does not display this dialog box.

Help
To display this, right-click the Update Service icon on the task tray and then click [Help].
This help is displayed.

Dialog Boxes

Proxy Server Settings

Set whether to use Proxy Server to retrieve latest information.When you set to use it, also configure the
settings to connect your Proxy Server and set the authentication method.

To display this dialog box, click [Proxy Server Settings] in the [Software Location] tab or [Driver Location]
tab of the [Update Service - Properties] window.

Use Proxy Server
To use Proxy Server, select this check box and set the following options.

e Address
Enter an IPv4 address, IPv6 addrses or a valid DNS address.
You can enter from 0O to 256 single-byte alphanumeric characters.

e Port
Enter a port number.
You can enter any number from 1 to 65535.

e Use Proxy Authentication
To use the proxy authentication, select this check box and set the following options.

+ User Name
Enter a user name for your proxy server.
You can enter from 0 to 256 single-byte alphanumeric characters.
Password
Enter the password for your proxy server.
You can enter from 0 to 256 single-byte alphanumeric characters.
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[OK]
Saves the content set, and closes the dialog box.

[Cancel]
Cancels the content set, and closes the dialog box.

Progress Status

This is displayed when processing starts, and closes when processing completes.

[Cancel]
Cancels processing in progress.

Run Result

Displays the execution results of the check, download, or installation of updates.

[Close]
Closes the dialog box.

Confirm

This dialog box is displayed before the beginning of the installation, or before the deletion of the update
package from [Update Service - Storage Location Management].

The items displayed in the list are targeted for processing.

[Yes]
Executes processing during operation.

[No]
Cancels the operation, and closes this dialog box.
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3 Diagnostics Utility Help

What is Diagnostics Utility?

When problems occur, Diagnostics Utility allows you to check the communication status within your
office LAN environment, and to collect system information and log information so that you can
determine the cause of the problem.

Flow of Operations
This section describes the flow of error diagnosis using Diagnostics Utility.

1. Start Diagnostics Utility.

2.Check connection status with device/server.
When you cannot determine the location where the error has occurred, proceed to Step 3.

3. Retrieve Windows/log information.

4. Exit Diagnostics Utility.
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Main Screen and Dialog Box

Main Screen

Screen Structure

This section describes the structure of the main screen.

[Check Connection Status] tab
Click this to confirm the communication status within an office LAN environment.
Displays the [Check Connection Status] tab.

[Retrieve Information] tab
Click this to collect system information or log information.
Displays the [Retrieve Information] tab.

[Log Settings] tab

Click this to specify whether to record a detailed log, and to specify the size limit of the log to be
recorded.

Displays the [Log Settings] tab.

[About]
Displays the version information of Diagnostics Utility.

[Exit]
Exit Diagnostics Utility.

[Check Connection Status] tab
This tab allows you to confirm the connection status with the network-connected devices and servers

for error diagnosis.

Device
Select this when adding a device for which to confirm the connection status.

Server
Select this when adding a server for which to confirm the connection status.

IP Address or Host Name
Enter the IP address or host name of the device or server for which to confirm the connection status.
You can enter this in IPv4 / IPv6 / FQDN (Fully Qualified Domain Name) format.

[Add]

Adds the device or server whose IP address is entered in [IP Address or Host Name] to [Devices/Servers
List].

Devices/Servers List
Lists the devices or servers for which to confirm the connection status.

[Delete]
Deletes the selected devices or servers from [Devices/Servers List].
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[Communication Settings]
Click this to confirm the connection status with the device via SNMP.
Displays the [Communication Settings] dialog box.

[Start]
Starts confirming the connection status with the devices or servers.

[Save]
Exports the results of the confirmation of the connection status with the devices or servers to a CSV file.

Connection Status Details
Lists the results of the connection status confirmation with the devices or servers.

[Retrieve Information] tab

This dialog box allows you to retrieve computer-related information such as system information and
network information, 1IS logs, and operation logs of the applications in ApeosWare Management Suite.
The retrieved information is saved to a ZIP-compressed archive.

Log Information Settings
e Specify Period For Log Retrieval
Specifies whether to retrieve log information within the specified period.
This is disabled by default.

Begin Date

Specifies the start date of the log retrieval period. Click ['W] to display the calendar and click the
date to be set.

The current date is set as the default value.

End Date

Specifies the end date of the log retrieval period. Click ['W] to display the calendar and click the date
to be set.

The current date is set as the default value.

|,L—|i\ Note

Click [<] or [>] to switch the month/year displayed in the calendar.

List of Information to Retrieve
Lists Windows information and the application name whose operation log is retrieved.
The following items are displayed by default.
e Windows Information

OS-related information such as the OS name, version, and resource, and network information such as
computer name and TCP/IP settings are written in "System.csv".

e {Name of ApeosWare Management Suite and its related software name} log

Displays the name of the software which can get an operation log such as ApeosWare Management
Suite.

e {Name of ApeosWare Management Suite and its related software name} information

Displays the name of the software which can get the settings information such as ApeosWare
Management Suite.
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[Add]

Selects log information or system information to be retrieved and adds it to [List of Information to
Retrieve].

[Select All]
Selects all system information and log information displayed in the list.

[Clear All]
Deselects the selected system information and log information displayed in the list.

Retrieval Result
Lists the results of the system information and log information retrieval.

[Retrieve]
Starts retrieving the system information and log information.

E,I—\l Note

When you retrieve logs from Flow Management, you are required to enter the user ID and password of
the system administrator for ApeosWare Management Suite after you click [Retrieve].

[Settings]
Displays the [Log Settings] dialog box.
Click this to configure the detailed settings for retrieving log information.

[Save]
Exports the results of the system information and log information retrieval to a CSV file.

Retrieval Result
The result of retrieving the information selected in [List of Information to Retrieve] is displayed as below.
e Windows Information

This is displayed when the check box for [Windows Information] is selected in [List of Information to
Retrieve]. This includes:

- Operating System Information
The information of your operating system such as the OS name, version and resources is written in
"System.csv".
Network Information
The information of your network such as the computer name and TCP/IP setting is written in
"System.csv".
Event log
Event logs are written in "Application.evt" (application log), "System.evt" (system log), and
"Security.evt" (security log) in the "EventlLog" folder.
lIS log
A log from the Web service in IIS (Internet Information Services) is written in the "W3SVC
(Sitelndex)" folder.
This log is created for each website with the index entered in (Sitelndex).
An error log from the Web service in IIS (Internet Information Services) is written in the "HTTPERR"
folder. The name for this log file can be "ERROR.log" or "ERROR#.log".
Process information
The list of running processes are written in "Process.csv".
- Application information
The list of installed applications are written in "Application.txt".

53



3 Diagnostics Utility Help

e Log Information

The [{Name of ApeosWare Management Suite and its related software name} log] selected in [List of
Information to Retrieve] is displayed.

e Software Information

The [{Name of ApeosWare Management Suite and its related software name} information] selected
in [List of Information to Retrieve] is displayed.

[Log Settings] tab

Select whether to record a detailed log for ApeosWare Management Suite installed on the system where
Diagnostics Utility is running.
Also, set the maximum size limit for the log to be recorded for ApeosWare Management Suite.

Log Information
Lists recordable log information.
Select with a checkmark if you want to record a detailed log.

Enable Log Size Limit
Specifies the maximum size for all logs recorded for ApeosWare Management Suite.

[Apply]
Sets the detailed log settings and the maximum size for all logs.

Dialog Box

Communication Settings

This dialog box allows you to specify the community name or user name to be used for communication
and confirm the connection status with the device.

I/L_l_“\ Note

Entry of the user name or community name of the device is required only when the default value is being
changed.
When there is no change, entry is unnecessary.

SNMP v1/v2
Select this to communicate with the device using SNMP v1 or v2 protocol.
e Community Name
Enter the community name for SNMP v1 or v2 protocol.

You can enter from 1 to 32 single-byte alphanumeric characters.

SNMP v3
Select this to communicate with the device using SNMP v3 protocol.
e User Name
Enter the user name to be used when accessing the device.
You can enter from 1 to 128 single-byte alphanumeric characters.
e Message Digest Algorithm
Select [MD5] or [SHA-1] for the SNMP v3 authentication protocol

54



Main Screen and Dialog Box

e Authentication Password
Enter the authentication password to be used when accessing the device.
You can enter from 8 to 32 single-byte alphanumeric characters.
e Message Encryption Method
Select [DES] or [AES-128] for the SNMP v3 encryption protocol.
e Encryption Password
Enter the password for encryption.

You can enter from 8 to 32 single-byte alphanumeric characters.

[OK]
Saves the content set, and returns the display to the previous page.

[Cancel]
Cancels the content set, and returns the display to the previous page.

[Help]
Displays this Help.

Log Settings

This dialog box allows you to specify the format and period for the log information to be retrieved.

Information Retrieval Settings
e Split File Into Following Unit Size
Specify whether to split the retrieved log information into multiple compressed files of a fixed size.
This is deselected by default.

[ ] Mbytes
Enter the size for the split files.

The default value is [1] MB.
e Set Password
Specify whether to set a password for the log information compressed files to be created.
This is deselected by default.

Password
Enter the password for protecting your compressed file.

Log Information Settings
e Mask Private Log Information
Specify whether to replace the personal information in logs with a hash value in hexadecimal.
This is deselected by default.
e Get Open Source Software Logs
Specifies whether to include the OSS (Open Source Software) log.
This is selected by default.

[OK]
Saves the content set, and returns the display to the previous page.
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[Cancel]
Cancels the content set, and returns the display to the previous page.

[Help]
Displays this Help.

About

Displays the version information of Diagnostics Utility.

[Close]
Closes the dialog box.
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Operation Descriptions

Starting / Exiting Diagnostics Utility
Starting Diagnostics Utility

Starting from the installation DVD-ROM

This section describes the procedure to start Diagnostics Utility from the installation DVD-ROM
attached to the product package.

1.Log in to the client computer or server as a user of the Administrators group.

2.Insert the installation DVD-ROM attached to the product package to the DVD drive on a server or a
client computer.
The installation menu automatically appears. When it does not appear automatically, execute
"Launcher.exe" in the root directory of the DVD-ROM drive.

3.In the installation menu, perform the following procedure.
(1) Select the [Tool List] tab.
(2) Select [Diagnostics Utility].
(3) Click [Start/Install].

When the [User Account Control] dialog box is displayed, click [Yes].
Diagnostics Utility starts and the [Diagnostics Utility] window appears.

Starting Copied Diagnostics Utility

This section describes the procedure to copy Diagnostics Utility from DVD-ROM to the hard disk and
start it.

Ellj Note

Diagnostics Utility can be operated with the remote desktop feature.

1.Log on to a server or a client computer as a user in the Administrators group.

2.Insert the installation DVD-ROM attached to the product package in the DVD drive on a server or a
client computer.

3. Open Explorer, go to the "cm\tools" folder in the DVD-ROM, and in the folder, copy the "dgt" folder to
anywhere in the computer.

4. Open the "dgt" folder and double-click the "ADTUl.exe" file.
When [User Account Control] dialog box is displayed, click [Continue].

Diagnostics Utility starts and the [Diagnostics Utility] window appears.

Starting Diagnostics Utility after being installed

This section describes the procedure to start Diagnostics Utility after being installed to a server or a
client computer.

Ll_l_“\ Note

Diagnostics Utility will be installed at the same time by installing ApeosWare Management Suite 2. For
details, see "Set up Guide".

1.Log on to a server or a client computer as a user in the Administrators group.
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2.Select [FUJIFILM ApeosWare Management Suite] > [Diagnostics Utility] in this order from the menu
which makes Windows programs start.
Diagnostics Utility starts and the [Diagnostics Utility] window appears.

Exiting Diagnostics Utility

1. Click [Exit].

Diagnose Error from Communication Status

Check Connection Status with Device/Server

Check the connection status with the network-connected devices and servers for error diagnosis.

1. Click the [Check Connection Status] tab.
2.Select [Device] to add a device or select [Server] to add a server.

3. Enter [IP Address or Host Name] of the device or server for which to confirm the connection status,
and click [Add].

Cllj Note

+ You can enter this in IPv4 / IPv6 / FQDN (Fully Qualified Domain Name) format.
- You can enter from 1 to 255 single-byte alphanumeric characters.

4. Repeat Steps 2 and 3 until all devices and servers for connection status confirmation are added.

I/{It\ Note

To remove a device or server you have added, select it from [Devices/Servers List], and then click
[Delete].

5. Click [Start] to start confirming the connection.
6. Confirm the content displayed in the list of communication status check results.

Refer

+ For confirming the connection status by communicating with the device via SNMP = "Changing
Communication Settings"

« For saving the confirmation results = "Exporting Check Results to CSV file"

Changing Communication Settings

To confirm the connection status with devices, set items such as the community name and the user
name in the [Communication Settings] dialog box.

1.From [Devices/Servers List] on the [Check Connection Status] tab, select the device for which to
configure the communication settings, and then click [Communication Settings].

2.Inthe [Communication Settings] dialog box, select [SNMP v1/v2] or [SNMP v3] as the communication
protocol.

3. Enter the community name for SNMP v1/v2 communication protocol, or enter the user name,
Message Digest Algorithm, authentication password, Message Encryption Method, and encryption
password for SNMP v3 communication protocol.

4. Click [OK].
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Exporting Check Results to CSV file

Exports the results of the confirmation of the connection status with the devices or servers to a CSV file.

1. Click [Save] when the communication status check results are displayed in the list of communication
status check results on the [Check Connection Status] tab.

2.In the [Save File] dialog box, specify the file name and the location to save the CSV file.

Retrieve Windows/Log Information and Diagnose Errors

Retrieve Information

Retrieve information such as system information, network information, error logs, and audit logs from
the client computer and save it to a ZIP-compressed archive.

1. Display the [Retrieve Information] tab.

2. Confirm [List of Information to Retrieve], and select or add log information items to be retrieved.
+ Toselect/ deselect the log information items from [List of Information to Retrieve], click [Select All]

or [Clear All].
- To add a log information item to be retrieved to [List of Information to Retrieve], click [Add] and

select the log file.
3. Click [Retrieve].
4. Click [Save].

5.In the [Save File] dialog box, specify the file name and the location to save the file.

Refer
- For changing the detailed settings for the log information items to be retrieved =>"Changing Log Settings"
+ For saving the retrieval results ="Exporting Check Results to CSV File"

Changing Log Settings
This dialog box allows you to specify the format and period for the log information to be retrieved.
1.0On the [Retrieve Information] tab, click [Settings].
2.In the [Log Settings] dialog box, set each item.
3. Click [OK].

Exporting Check Results to CSV File

Exports the results of the system information and log information retrieval to a CSV file.

1. Click [Save] when the retrieval results are displayed.

2.In the [Save File] dialog box, specify the file name and the location to save the CSV file.
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Log Recording Settings

Set whether to record a detailed log for ApeosWare Management Suite installed on the system where
Diagnostics Utility is running.
Also, set the maximum size limit for the log to be recorded for ApeosWare Management Suite.

,/L—Ii\ Note

Record the detailed log only when instructed by a FUJIFILM Business Innovation service technician.
1. Display the [Log Settings] tab.
2.From [Log Information], select with a checkmark for the log information to record for the detailed log.

3. When you want to set the maximum size limit for the log, select with a checkmark for [Enable Log Size
Limit].

4. Click [Apply].
Checking Version Information

Confirm the version information of your Diagnostics Utility.

1.0n the main screen, click [About] to display the [About] dialog box.

2.Click [Close].

60



Multi Component Log Viewer

Multi Component Log Viewer

You can display logs retrieved from the Diagnostics Utility, as well as PC logs used for launching the
Diagnostics Utility, as a log summary.

About Multi Component Log Viewer

Describes the screens for Multi Component Log Viewer.
Menu bar

File
o Exit

Exits Multi Component Log Viewer.

Action
e Open Log File
Specifies log file retrieved from Diagnostics Utility. You can select the folder.
e Open Local Computer Log
Specifies log from PC running Diagnostics Utility.

View
e Show Log Details
Shows details of log selected from log summary.
e Add/Remove Columns
Opens the [Add/Remove Columns] dialogue box. You can select items to be displayed in log summary.
e Show Toolbar
Select whether to display [Action Buttons] and [View Bar].
e Refresh
Refreshes log summary to the most current state.
e Log Level

Select from [[Fatal] Level], [Error] Level and Above and [Warning] Level and Above for log summary
to be displayed.

e Log Type
You can select and display checkmarked items of the log summary taken from the System Log and the
Audit Log.

Help

e Diagnostics Utility
Displays the Help for this tool.

e About
Displays the version of the Diagnostics Utility.

Summary

Displays logs selected to display, with the following headings.
e Log Level
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e Date/Time Occurred
e Software Name

e Type

e JObID

e Local Host ID

This item is not displayed by default. To display, go to [View] > [Add/Remove Columns] and select
with a checkmark.

e ComponentID

This item is not displayed by default. To display, go to [View] > [Add/Remove Columns] and select
with a checkmark.

e User ID

This item is not displayed by default. To display, go to [View] > [Add/Remove Columns] and select
with a checkmark.

e Client Host ID

This item is not displayed by default. To display, go to [View] > [Add/Remove Columns] and select
with a checkmark.

e Log Number
e Component Description
e Sub-Component Description

This item is not displayed by default. To display, go to [View] > [Add/Remove Columns] and select
with a checkmark.

e Stack Trace

This item is not displayed by default. To display, go to [View] > [Add/Remove Columns] and select
with a checkmark.

To launch Multi Component Log Viewer

1.Open "{DVD-ROM drive}:\cm\tools\dgt".

2.Double-click [ADTLogViewer].
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4 Popup Messenger Help

What is Popup Messenger?

Popup Messenger allows you to receive notifications such as the print results of the print jobs that you

issued, and to display them on your computer. Moreover, you are enabled to change the setting of the
print job, and the user and someone to be charged.

Operation Description

Flow of Initial Settings

This section describes the flow of operations to configure the environment settings for receiving popup
notifications.

Perform this operation when you operate Popup Messenger initially.

1.Log on to the client computer.

2.Double-click the icon of Popup Messenger on the desktop.
The [Popup Messenger] dialog box appears.

3. Configure other settings as necessary.
Configure any optional items in the environment settings dialog box.
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Main Screens

[Popup Messenger] dialog box
This is the main screen that allows you to configure Popup Messenger.

[Start]
Starts Popup Messenger.
This item can not be clicked when Popup Messenger is already running.

l:l: Note
No icon is displayed on the task tray even when Popup Messenger is running.

[Stop]
Stops Popup Messenger.
This item can be clicked only when Popup Messenger is running.

[About]
Displays the [Popup Messenger Version Information] dialog box.

Environment settings
Displays the Environment settings dialog box.

[Close]
Closes the [Popup Messenger] dialog box.

Environment settings dialog box
This is for editing the environment settings file.

[User name]
Enter user name. You can enter 1 to 256 single-byte alphanumeric characters.

|/L_|i\ Note

Once the user name is registered, even if uninstallation and reinstallation are done, the information of the
registered user name is retained.

[Password]
Enter password. You can enter 1 to 50 single-byte alphanumeric characters.

[OK]
Save the settings and close the dialog box.

[Cancel]

Cancel the settings and close the dialog box.

[Popup Messenger Version Information] dialog box
Displays the version information of Popup Messenger.

[OK]
Closes the dialog box.
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Print Job Setting Screens

[Print Details] window

Appears after sending a print job. Allows you to change print job setting, as well as to set user and
account information.

Messages for Print rules

The message appears if print rules set by administrator apply to the print job and [Override the rule]
option is enabled.

If disabling print rules and executing the print job, check [Override the rule].
To cancel print job, click [cancel].

Li_l_“\ Note

Administrator sets print rules in ApeosWare Management Suite.

[Job Name]
Displays the name of the print job.
Change the job name on [Change Job Name] window appearing by clicking the icon.

[User]
Select user name.

To change the user name, authenticating the user on [Enter Password] window displayed by clicking the
icon enables the user to print the job.

|£I_\\ Note

User name corresponding to the job owner is displayed. Moreover, you can select sub user related to the
default user.
[Account]
The account and its balance or limit will be displayed.
To use an account for each user, select account name.
"Account" is like an account which print charge is paid from. A user can own one or more accounts.

‘:||—\| Note

+ Account name related to user is displayed as default. If any account related to user doesn't exist, an account
name related to the user group is displayed.

+ A sub- account is displayed when the main account is related. The main account is not displayed.

[Global Account]
If there is no individual account for each user, select the account that all users can share.
Useful for performing accounting tasks for each job.
If the account name to be used doesn't appear, you can add it on [Select All User Accounts] window
appearing by clicking the icon.
[Charge with global account]
If selecting an item other than [No] on [Global Account], check the box.
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[Override Job Cost]

In the case of inappropriate account or insufficient the balance, you can print without having specified
an account.

In this case, check the box.

[Reason for Global Account Usage]
If checking [Override Job Cost], you are required to enter the reason.
You can enter 1 to 128 characters.

|/L_|i\ Note

If checking [Override Job Cost], you must be filled in the box.

[Job Cost(\)]
Displays the print charge.

[Paper Size]
Specify paper size to be printed.

|:/|i\ Note

To copy documents with mixed-size originals, select [Auto].

[Output Color]
Specify color mode.

C,I—\l Note

- No setting is possible in the following cases. (Black-and-white is set.)
-When compulsive black-and-white is set in the access profile
-When black-and-white is set in the print rule

+ When print job is "Mixture of color/black-and-white" or print job is "Color only" or print job is "2-color",
"Color (auto judgment)" or "Black-and-white" can be selected.

+ When print job is "Black-and-white", only "Black-and-white" can be selected.

[2-Sided Print]
Specify Two-Sided printing and determine how to bind your two-sided printed sheets job.

‘:||—\| Note

There may be instances when you can't change the setting depending on print rules or user profiles set by
administrator.

[Copies]
Specify the number of sets to be printed from 1 to 999.

[Print]
Closes the window, and then executes the print job.
Not displays in the case the print job is canceled when the print rule is applied.

[Cancel]

Cancels print job. Clicks [OK] on the confirmation screen that is displayed when the [Cancel] is clicked
and closes the window.

[Change Job Name] window

Change the job name.
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[Job Name]
Enter the job name. You can enter 1 to 64 characters.

[OK]
Saves the job name and moves to the [Print Details] window.

[Cancel]
Cancels the settings and moves to the [Print Details] window.

[Enter Password] window

If user name to be used isn't displayed on [Print Details] window, the user can be authenticated here in
order to be enabled to execute the print job temporarily.

[User Name]
Enter user name. You can enter 1 to 256 single-byte alphanumeric characters.

[Password]
Enter password. You can enter 1 to 50 single-byte alphanumeric characters.

[Authenticate]
Authenticates the user entered and moves to the [Print Details] window. Account information related to
the user is also incorporated.

[Cancel]
Cancels the settings and moves to the [Print Details] window.

[Select All User Accounts] window
Search an account which users can share and add the [Global Account] in the [Print Details] window.

[Search]

After selecting the search target from the [Parent/Sub Account], [Parent Account] or [Sub Account] in
the combo box, enter the keywords to be searched in the text box. You can enter 1 to 256 single-byte
alphanumeric characters.

When the icon is clicked, the list of search results will be displayed.

I/L_l_“\ Note

Even if choosing [Parent Account], a sub-account will be displayed as search results.

[Select Account]

The list of [Sub Account Name], [Parent Account] and [Balance(\)] of the global account searched for
will be displayed.

Select the global account to be added.

[Add]
Adds the selected global account and moves to the [Print Details] window.

[Cancel]
Cancels the settings and moves to the [Print Details] window.
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Cancel Notification Window

Displays when the print job is canceled by ApeosWare Management Suite processing.
Confirms the reason why the print job is canceled

l:,l—\l Note

+ This window is displayed when the setting displays the print job status on pop-up screen by the user, who
executes the print, access profile

- If the users canceled the print job by themselves or the print job is canceled when the expiration date is
passed, it should not be notified

[Job Name]
The job name of canceled print job is displayed.

Job Date/Time Created
The date when the print job is created is displayed.
The display format depends on the language that the user selects.

[Reason]
The reason why the print job is canceled is displayed.

[Close]
Closes the window.
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Color print warning dialog box

Itis displayed if the color mode is set to "Color" when [Print] is clicked in [Print details] window.

Refer
How to set functions— "Color print warning notification" in "Function guide"

[OK]
Execute the process that is operating.

[No]
Cancel the process that is operating and close the window.
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